# Table of Contents

1. **Start Successfully**
   1.1 About the Manual
   1.2 About Nero Express
   1.3 Versions of Nero Express
   1.4 Working with the Application
   1.5 Starting the Program
   1.6 System Requirements

2. **Start Screen**
   2.1 Extended Area (Start Screen)

3. **Compilation Screen**

4. **Data Disc**
   4.1 Compiling Data Disc
   4.2 Compiling SecurDisc disc
   4.3 Saving Data Track

5. **Music**
   5.1 Compiling Audio CDs
      5.1.1 Customizing Properties of The Audio File
         5.1.1.1 Track Properties Tab
         5.1.1.2 Indexes, Limits, Split Tab
         5.1.1.3 Filters Tab
   5.2 Compiling Jukebox Disc
   5.3 Automatic Music Recognition
      5.3.1 Identifying Audio Files
   5.4 Copy Audio CDs to Hard Drive
      5.4.1 Copy Audio CDs to Hard Drive
         5.4.1.1 Source Tab
         5.4.1.2 Output Tab

6. **Video**
   6.1 Compiling DVD-Videos
   6.2 Compiling Blu-ray Video Disc
   6.3 Compiling AVCHD Video Disc

7. **Loading a Disc Image or Saved Project**

8. **LightScribe**
# Table of Contents

8.1 Printing LightScribe Label 45
8.2 LightScribe Print Properties Window 47
9 Labelflash 49
9.1 Burn Label Window 49
9.2 Printing Labelflash Labels and DiskT@2 51
10 Burn Compilation 53
10.1 Choice of Burner 53
10.2 Starting the Burn Process 54
10.3 Creating an Image File 54
10.4 Final Burn Settings Screen 56
10.4.1 Extended Area (Burn Settings) 57
11 Copying a Disc 59
11.1 Methods of Copying 59
11.1.1 On-the-fly Copying 59
11.1.2 Copy Over Image 59
11.2 Copying a Disc 60
11.3 Copy Settings 62
12 Erase Rewritable Disc Window 64
13 Final Screen 66
14 About Nero SecurDisc Viewer 67
14.1 Starting Nero SecurDisc Viewer 67
14.2 Copying Data to Hard Drive 68
14.3 Checking Data Integrity 69
14.4 Checking Signature 69
15 Nero MediaBrowser 71
16 Configuration Options 74
16.1 Compilation Settings 75
16.2 Cache Settings 76
16.3 Expert Features 76
16.4 Ultrabuffer Settings 77
16.5 LightScribe Settings 78
17 Glossary 79
18 Index 82
19 Contact 84
1 Start Successfully

1.1 About the Manual

This manual is intended for all users who want to learn how to use Nero Express. It is process-based and explains how to achieve a specific objective on a step-by-step basis.

To make best use of this documentation, please note the following conventions:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Indicates warnings, preconditions or instructions that have to be precisely followed.</td>
</tr>
<tr>
<td>💡</td>
<td>Indicates additional information or advice.</td>
</tr>
<tr>
<td>1. Start …</td>
<td>The number at the beginning of a line indicates a prompt for action. Carry out these actions in the order specified.</td>
</tr>
<tr>
<td>➡️</td>
<td>Indicates an intermediate result.</td>
</tr>
<tr>
<td>➡️</td>
<td>Indicates a result.</td>
</tr>
<tr>
<td>OK</td>
<td>Indicates text passages or buttons that appear in the program interface. They are shown in boldface.</td>
</tr>
<tr>
<td>(see…)</td>
<td>Indicates references to other chapters. They are executed as links and are shown in red and underlined.</td>
</tr>
<tr>
<td>[...]</td>
<td>Indicates keyboard shortcuts for entering commands.</td>
</tr>
</tbody>
</table>

1.2 About Nero Express

Nero Express provides all the performance and efficiency of Nero Burning ROM with a simplified user interface. Whether you are a beginner or an expert, Nero Express guides you quickly and easily through your desired burning tasks. The default settings are selected to automatically produce the best possible results. Using the program is remarkably easy: simply select the project to be burned, add the files, and start burning.

With Nero Express that is included in Nero 12 you can save audio files from an Audio CD to the hard drive. In the process, the files are encoded, i.e. converted into a format that the computer can read. The Audio CD can be automatically identified with Gracenote. So called metadata such as title, genre, and track title are accessed by the Gracenote Media Database and associated to the tracks. That way you have audio files that are accurately and fully named after the encoding process.
1.3 Versions of Nero Express

Nero Express is available in versions with different features.

The full version of Nero Express in Nero 12, or Nero 12 Platinum provides the complete range of functions, including multimedia features such as saving audio tracks and burning BD-Videos.

Different versions of Nero Express Essentials are available. Essentials or OEM software may differ from the full version in a more or less broad functional range. The feature limitations of your single Essentials version are determined by the contract partner from whom you purchased your copy.

Nero Express Essentials in Nero 12 may not offer the following features compared to the full version:

- Creating labels with LightScribe
- Creating labels with Labelflash
- Full SecurDisc functionality
- Audio CD compilation
- AVCHD compilations
- BDMV compilation
- DVD-Video compilation
- Jukebox compilation
- Burn from Image
- ISO support
- Copying discs
- Simultaneous burning with multiple burners
- Cross fade with previous track
- Save Tracks
- Music title recognition with Gracenote
- Support of Album art with Gracenote

Gracenote Plug-in

You will need the Gracenote Plug-in to identify single audio files and to display Album art.

You can obtain the plug-in at [www.nero.com](http://www.nero.com). The plug-in is already included in the full version of Nero Express in Nero 12 or Nero 12 Platinum.
In addition, the encoding and decoding formats in Nero Express Essentials are restricted. The mp3PRO Plug-in is included as a trial version.

**mp3PRO Plug-in**
You will need the mp3PRO Plug-in for unlimited MP3 and mp3PRO encoding/decoding.
The plug-in can be added to Nero 12. You can obtain the plug-in at www.nero.com. The plug-in is already included in the full version.

Nero Express in Nero BurnExpress 2 provides basically the same feature range as the full version of Nero Express in Nero 12 or Nero 12 Platinum.
The following feature is not available:
- SecurDisc Surface Scan
- mp3 Pro Encoding

The following features are limited to a trial version:
- Music title recognition with Gracenote
- Support of Album art with Gracenote
You will need the Gracenote Plug-in to use the Gracenote features permanently. You can obtain the plug-in at www.nero.com.

### 1.4 Working with the Application

The main function of Nero Express is to select files and folders and to burn them to a disc. This is done in three basic steps. For each step, a new screen is displayed:

- Select a task in the start screen.
- Select the files to be burned.
- Start the burn process.

Additionally, you can set options regarding the files in the compilation and regarding the burn process.

### 1.5 Starting the Program

There are several ways to open Nero Express, depending on various factors such as the product you have installed and the operating system you are using.

- On Windows 7 and earlier versions of Windows, you can start Nero Express via:
  - Start (the start icon) > (All) Programs > Nero > Nero 12 > Nero Express

- the Nero 12 Welcome Application if you use Nero 12
The Welcome Application offers information about the main use cases and links to tutorials and other interesting Internet sites by Nero.

To start the Welcome Application, click the Nero 12 icon on your desktop (Windows 7 and earlier) or select the Nero 12 tile on the application selection screen (Windows 8).

- On Windows 8, you can start Nero Express via:
  - the Nero 12 tile (Windows 8 style user interface) or the Nero 12 desktop icon (desktop user interface) if you use Nero 12
  - the Nero Express tile (Windows 8 style user interface) or the Nero Burning ROM 12 desktop icon (desktop user interface) if you use Nero Burning ROM 12 as a standalone product

1.6 System Requirements

Nero Express is part of the Nero product you have installed. Its system requirements are the same. Detailed system requirements of this and all other Nero products can be found in the Support section on our Web site www.nero.com.
2 Start Screen

The main screen in Nero Express is the starting point for all actions. Click here on the relevant menu icons to go to the desired screen where you can compile and work on your project. The selection is categorized into two areas: several formats or options are available for the single compilation methods.

Click the button in the left margin of the window to display an extended area with additional options and features.

The following compilation methods are available:

<table>
<thead>
<tr>
<th>Date</th>
<th>Allows you to compile and burn all types of files and folders.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Music</td>
<td>Allows you to compile and burn audio files as Audio CD for example.</td>
</tr>
<tr>
<td>Videos</td>
<td>Allows you to compile and burn video files as DVD-Video for example.</td>
</tr>
<tr>
<td>Image, Project, Copy</td>
<td>Allows you to copy a source disc and to load an image file or a saved project.</td>
</tr>
<tr>
<td>Print LightScribe Label</td>
<td>Displays the Disc Label screen. This is where you can create or load a label in order to print on the label side of special CDs/DVDs in the recorder. A Lightscribe recorder must be selected to enable the option. Only available in the full version of Nero Express in Nero 12.</td>
</tr>
</tbody>
</table>
2.1 Extended Area (Start Screen)

You can access the additional options and features in the extended area of the start screen by clicking on the button in the left margin of the window. The extended area is available in all Nero Express screens.

The following menu icons are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch to Nero Burning ROM</td>
<td>Closes Nero Express and opens the start screen of Nero Burning ROM. Nero Burning ROM is able to open Nero Express compilation files and Nero Express is able to open Nero Burning ROM compilation files. This option is only available in the extended area of the start screen. If you decide to create a project with Nero Express, the option <strong>Saves the active project</strong> is displayed in all of the other windows at this point. Only available with Nero 12.</td>
</tr>
<tr>
<td>Saves the active project</td>
<td>Opens the <strong>Save As</strong> window to save your compilation. The file links and settings to be burned are saved.</td>
</tr>
<tr>
<td>Options</td>
<td>Opens the <strong>Options</strong> window to customize Nero Express to suit your requirements.</td>
</tr>
<tr>
<td>Save Audio Tracks</td>
<td>Opens the <strong>Copy Audio CDs to Hard Drive</strong> to copy audio files from CD to the hard drive. Only available with Nero 12.</td>
</tr>
<tr>
<td>Save Data Track</td>
<td>Opens the <strong>Select Track</strong> window in which you can save the track of a data disc as an image file.</td>
</tr>
</tbody>
</table>
### Erase Disc
Opens the **Erase Rewritable Disc** window to erase data from a rewritable disc.

### Disc Info
Opens the **Disc Info** window to display information about the inserted disc. The total capacity and available capacity are displayed, in addition to the tracks and sessions.

### Create Covers and Labels
Opens Nero CoverDesigner. Nero CoverDesigner is used to create and print labels and booklets for burned discs. Please see the separate Nero CoverDesigner user manual for full instructions on how to make professional looking covers and labels. Only available with Nero 12.

### SecurDisc Settings
Defines the settings for burning a SecurDisc disc.

### Burn Label
Opens the **Burn Label** window, in which you can create or load a label in order to print a label and/or print directly on the data side of special discs in the recorder. Available with a Labelflash recorder only. The recorder must be selected to enable the option. Only available in the full version of Nero Express in Nero 12.

### Recorder
Defines the recorder that you want to use for burning and/or the Nero Image Recorder.

---

**See also**
- Configuration Options →74
- Copy Audio CDs to Hard Drive →35
- Erase Rewritable Disc Window →64
### 3 Compilation Screen

You can access the Nero Express compilation screens by selecting the compilation type you want in the start screen. You can add data to your projects in the compilation screens and customize the directory structure on the disc to suit your requirements. The capacity bar near the bottom of the window indicates how much space is being used by the data on the disc. Essentially, all compilation screens have the same structure.

![Compilation screen](image)

The following setting options are in general available in the compilation screen:

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Opens the <strong>Add files and folders</strong> window. Clicking on the little triangle allows you to open Nero MediaBrowser in order to add media files.</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes the selected file.</td>
</tr>
<tr>
<td>Play</td>
<td>Plays a selected audio or video file.</td>
</tr>
<tr>
<td>Back</td>
<td>Returns to the start screen.</td>
</tr>
<tr>
<td>Next</td>
<td>Switches to the <strong>Final Burn Settings</strong> screen.</td>
</tr>
</tbody>
</table>

The following setting options are additionally available for **Audio CD** compilation:
**Compilation Screen**

<table>
<thead>
<tr>
<th>Button</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the <strong>Audio Track Properties</strong> window for Audio CDs.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Check box</th>
<th>Normalize all audio files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enables a filter that brings the volume of the audio files to be burned into line with one another. This is recommended particularly if the files originate from different sources.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Check box</th>
<th>No pause between tracks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Establishes that the audio files merge into one another without a pause. If the check box is cleared, a pause of two seconds is inserted between the files.</td>
<td></td>
</tr>
</tbody>
</table>

- **Actual capacity of media formats**

  The actual capacity of the DVD5, DVD9, BD DL, and BDXL media formats is less than as stated by the disc manufacturers. For example, the actual capacity of a 4.7 GB DVD5 is around 4.38 GB only.

  This is because of different conversion systems. A DVD5-media format can handle 4,700,000,000 bytes, but this number is not equal to the 4.7 GB stated by the disc manufacturers. The correct conversion factor for bytes is not 1000, but 1024:

  - 1024 byte = 1 KB
  - 1024 KB * 1024 KB = 1 MB
  - 1024 KB * 1024 KB * 1024 KB = 1 GB

  A DVD can handle 4,700,000,000 bytes:

  - 4,700,000,000 bytes = 4,589,843 KB = 4,482 MB = 4.377 GB

  The capacity bar in Nero Express will always show you the correct amount of capacity.
Compilation Screen

bytes measured in MB or GB.

💡 You can find more information on Blu-ray support at www.nero.com/link.php?topic_id=416.

See also

Compilation Settings →75
4 Data Disc

4.1 Compiling Data Disc

With Nero Express you can compile and burn all types of files and folders. If a Blu-ray recorder is installed on your computer you can burn data CDs, data DVDs and data Blu-ray Discs. If you have a CD recorder you can only burn data CDs. The procedure for all data compilation methods is identical.

A data disc is particularly useful for storing files on a disc and for burning backups.

You can find more information on Blu-ray support at www.nero.com/link.php?topic_id=416.

To create a data disc, proceed as follows:

1. Click the Data menu icon in the Nero Express start screen.
   → The data disc options are displayed.

2. Click the option you require: Data CD, Data DVD, or Blu-ray Data Disc.
   → The Disc Content compilation screen for data discs is displayed.

3. If you want to add files using your browser:
   1. Click the Add button.
      → The Add files and folders window is opened.

4. If you want to use Nero MediaBrowser to add media files:
1. Click the triangle next to the Add button and choose Add > File from Nero MediaBrowser.
   ➔ Nero MediaBrowser is opened.

5. Select the files that you want to add to the compilation and click the Add button.

6. Repeat the previous step for all files that you want to add.

7. Click the Close button.
   ➔ The files are added to the compilation and displayed in the compilation screen.

8. Click the Next button.
   ➔ You have successfully compiled a data disc and can now burn this compilation.

See also

Compilation Screen →12

4.2 Compiling SecurDisc disc

SecurDisc is a technology with which you can create discs with special protection properties. No special hardware is needed.

Discs that are created with Nero Express and the SecurDisc compilation type include data integrity and reconstruction. Additional SecurDisc features include the possibility to protect the data on your disc against unauthorized access using a password, to digitally sign the disc, and to configure the data redundancy.

To be able to copy the protected data to your hard drive and to check the security of the data you will need a special application named Nero SecurDisc Viewer. The Nero SecurDisc Viewer is burned automatically to the SecurDisc disc and can be downloaded free of charge at www.securdisc.net or www.nero.com.

More information on SecurDisc technology can be found at www.securdisc.net.

This function is limited in the Essentials version. The full version offers unlimited password protection, unlimited data redundancy, and the digital signature feature. You can always upgrade your Essentials version at www.nero.com to get the full version with all the functions.

To compile a SecurDisc disc, proceed as follows:

1. Click the Data menu icon in the Nero Express start screen.
   ➔ The data disc options are displayed.

2. Click the SecurDisc option you require.
   ➔ The Disc Content compilation screen for SecurDisc discs is displayed.
3. If you want to add files using your browser:
   1. Click the Add > Files button.
      ➨ The Add files and folders window is opened.

4. If you want to use Nero MediaBrowser to add media files:
   1. Click the triangle next to the Add button and choose Add > File from Nero Media-Browser.
      ➨ Nero MediaBrowser is opened.

5. Select the files that you want to add to the compilation and click the Add button.

6. Repeat the previous step for all files that you want to add.

7. Click the Close button.
   ➨ The files are added to the compilation and displayed in the compilation screen.

8. If you want to enable the password protection for all files:
   1. Select the Password protection check box in the extended area of the compilation screen.
      ➨ The SecurDisc – Protect Data window is opened.
2. Enter the desired password in the **Password** input area and then click the **OK** button.
   - A lock symbol shows that all data is protected.

When appropriate, a wizard offers suggestions in an additional **Tips** dialog box when entering and selecting the password. The wizard estimates the security level, i.e. the quality of the password, during entry.

9. If you want to sign the disc with a digital signature:
   1. Select the **Digital signature** check box in the extended area of the compilation screen.
   - The **SecurDisc – Digital Signature** window is opened.
2. If you have already created a digital key, click the Browse button and select the key.

3. If you want to create a digital key, click the Start button.
   - The SecurDisc – Create Digital Key window is opened.

4. Read the instructions and click the Next button.
   - The SecurDisc Key Creation Process window is opened.

5. Move your mouse at random until the creation process is complete.
   - Nero Express uses the random data to create the SecurDisc key. You can monitor the status of the creation process using the progress bar. The Next button is enabled as soon as the process is complete.

6. Click the Next button.
   - The SecurDisc – Key Creation Completed window is opened.

7. Enter a file name for the key you have created and click the Finish button.
   - The SecurDisc – Digital Signature window is opened again and the selected key appears in the drop-down menu.

8. Click the OK button.
   - The corresponding window is opened to inform you that the disc is being digitally signed with the selected key.

9. Click the OK button.
You can pass on the relevant public key to recipients to enable them to verify the signature.

10. If you want to enhance the burning speed by limiting the data redundancy or to configure the data redundancy:
   1. Select the Data redundancy check box in the extended area of the screen.
      - The option buttons are enabled.
   2. Select the desired reliability level.

   If the Data redundancy check box is cleared, the disc will be filled completely with copies of the chosen data and checksums. A display panel in the compilation screen indicates the current redundancy level.

11. Click the Next button.
   - You have compiled a SecurDisc disc with settings according to your requirements and can now burn the disc.

4.3 Saving Data Track

With Nero Express you can save a data disc as an image file. The image file can later be burned to a recordable disc. The result is a copy of the original data disc.

To save the data disc as an image file, proceed as follows:

1. Insert the data disc in a drive.

2. Click the Save Data Track button in the extended area of the start screen.
   - The Select Track window is opened. The tracklist shows you the sessions and data tracks that are found on the disc. Due to the technical reasons, only the first data track of the first session can be saved.
3. Select the first data track.

4. Click the **Save Track** button.
   - The **Save As** window is opened.

5. Select a file name and a storage location.

6. Select the desired output format (ISO or NRG) for the image file in the **Save As** drop-down menu.

7. Click the **Start** button.
   - The **Progress** window is opened and displays the progress made while saving. When the save process is complete, the window is closed automatically.
   - You have successfully created an image file starting from a data disc. Now you can burn the image file to a disc.
5 Music

5.1 Compiling Audio CDs

Some of the functions mentioned here are restricted or not available in the Essentials version. You can always upgrade your Essentials version at www.nero.com to get the full version with all the functions.

With Nero Express you can create an Audio CD that contains music files. It can be played in all standard CD players. To compile an Audio CD, source files with different audio formats are automatically converted into Audio CD format before being burned.

Some CD players cannot play CD-RWs. Use CD-R discs to burn Audio CDs.

The encoding and decoding formats in the Essentials version are limited. You can always upgrade your Essentials version at www.nero.com to get the full version with all the functions.

mp3PRO Plug-in
You will need the mp3PRO Plug-in for unlimited MP3 and mp3PRO encoding/decoding.

The plug-in can be added to Nero 12. You can obtain the plug-in at www.nero.com. The plug-in is already included in the full version.

To create an Audio CD, proceed as follows:

1. Click the Music menu icon in the Nero Express start screen.
   ➤ The compilation methods for music are displayed.

2. Click the Audio CD button.
   ➤ The My Audio CD compilation screen for Audio CDs is displayed.
3. If you want to add files using your browser:
   1. Click the **Add > Files** button.
      - The **Add files and folders** window is opened.

4. If you want to use Nero MediaBrowser to add audio files:
   1. Click the triangle next to the **Add** button and choose **Add > File from Nero MediaBrowser**.
      - Nero MediaBrowser is opened with the **Music** tab enabled.
   5. Select the audio file that you want to add to the compilation and click the **Add** button.
   6. Repeat the previous step for all audio files that you want to add.
   7. Click the **Close** button.
      - The audio files are added to the compilation and displayed in the compilation screen.
8. Customize the properties of the audio files to suit your requirements.

9. Click the **Next** button.
   - You have successfully compiled an Audio CD and can now burn this compilation.

**See also**

- Compilation Screen →12
- Copy Audio CDs to Hard Drive →35

### 5.1.1 Customizing Properties of The Audio File

You can display and/or make changes to the audio file properties on the **Track Properties**, **Indexes**, **Limits**, **Splits** and **Filters** tabs of the **Audio Track Properties** window. To open the window, select an audio file in the compilation screen **My Audio CD** for Audio CDs and click the **Properties** button.

#### 5.1.1.1 Track Properties Tab

On the **Track Properties** tab you will find basic information on the selected file in the **Source information** area. To open the window, mark an audio file in the compilation screen for Audio CDs and click the **Properties** button.
The following input areas are available in the **Properties** area:

<table>
<thead>
<tr>
<th>Input field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title (CD Text)</strong></td>
<td>Defines a title which is saved as CD Text. CD players that support CD Text show the title name entered here. Only Latin characters can be displayed as CD Text. CD Text can only be written in disc-at-once mode.</td>
</tr>
<tr>
<td><strong>Artist (CD Text)</strong></td>
<td>Defines the artist which is saved as CD Text. CD players that support CD Text show the artist's name entered here. Only Latin characters can be displayed as CD Text. CD Text can only be written in Disc-At-Once mode.</td>
</tr>
<tr>
<td><strong>Pause</strong></td>
<td>Defines the length of the pause in seconds or frames between the selected audio file and the previous one.</td>
</tr>
<tr>
<td><strong>International Standard Recording Code (ISRC)</strong></td>
<td>Identifies the CD title using a 12-character digital code. The ISRC is entered in the subcode and included silently. If you do not know the ISRC, you should leave this input field blank.</td>
</tr>
<tr>
<td><strong>Protection</strong></td>
<td>Sets the copy protection bit for the corresponding track on the Audio CD. As most CD recording applications simply ignore this bit, copy protection cannot be ensured. A warning message will be opened in Nero Express while copying an Audio CD with copy protected tracks.</td>
</tr>
</tbody>
</table>
Check box

Cross fade with previous track

Defines a crossfade between this and the previous audio file. You can specify the length of the crossfade in seconds or in sectors.

5.1.1.2 Indexes, Limits, Split Tab

On the Indexes, Limits, Split tab you can set and delete indexes and split audio files to create two or more shorter ones. The tab consists of the Oscilloscope and Positions areas.

Audio files are displayed graphically in the Oscilloscope area. The following configuration options are available in the Positions area:

<table>
<thead>
<tr>
<th>Selection lists</th>
<th>Shows the positions for the beginning and end of the audio file on the CD.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start/End</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Button</th>
<th>Sets a new index position at the selected position. For the CD player this is the position from which a new song starts, and the player can also jump to it directly. However, not all CD players support this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Index</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Button</th>
<th>Opens the Edit track limit dialog box. You can enter the exact position of a split.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes a selected index.</td>
</tr>
<tr>
<td>Split</td>
<td>Splits the audio file at the marked position.</td>
</tr>
<tr>
<td>Play</td>
<td>Plays the audio file from the marked position. During playback, the Stop playing button is displayed.</td>
</tr>
<tr>
<td>Stop playing</td>
<td>Stops playback of the audio file. If playback is stopped, the Play button is displayed again.</td>
</tr>
<tr>
<td>Split at Index Positions</td>
<td>Splits the audio file at the set index positions.</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Enlarges the graphical representation of the audio file.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Reduces the graphical representation of the audio file.</td>
</tr>
<tr>
<td>Full View</td>
<td>Displays a graphical representation of the entire audio file.</td>
</tr>
</tbody>
</table>

### 5.1.1.3 Filters Tab

The Filters tab includes filters that improve or change the quality of the music. The so-called non-destructive procedure is used for processing, i.e. the actual recording is not changed, but flags are simply set that can be canceled at any time. No additional audio data is created. The audio files on hard drive are not modified during this procedure.
The following configuration options are available in the **Audio Track Properties** window:

<table>
<thead>
<tr>
<th>Check box</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Normalize</strong></td>
<td>Sets the volume of an audio file to a preset value. This filter can be useful to bring the volume of files originating from different sources into line with one another.</td>
</tr>
<tr>
<td><strong>Declick</strong></td>
<td>Removes clicking and scratching noises, such as those on old LPs for example.</td>
</tr>
<tr>
<td><strong>Hiss Reduction</strong></td>
<td>Reduces or removes the hiss on an audio file. All frequencies below a certain threshold (hiss level) are removed.</td>
</tr>
<tr>
<td><strong>Fade In</strong></td>
<td>Fades in the volume of an audio file from zero to full volume. This filter can be useful for shortening files.</td>
</tr>
<tr>
<td><strong>Fade Out</strong></td>
<td>Fades out the volume of an audio file from full volume to silence. This filter can be useful for shortening files.</td>
</tr>
<tr>
<td><strong>Stereo Widening</strong></td>
<td>Increases/reduces the stereo effect of an audio file. This filter only works if the original file was recorded in stereo.</td>
</tr>
<tr>
<td><strong>Karaoke</strong></td>
<td>Fades out the vocals on an audio file. This is done by fading out the parts of a song that are the same in both stereo channels.</td>
</tr>
</tbody>
</table>
5.2 Compiling Jukebox Disc

Nero Express can be used to compile discs with audio formats you require (e.g. Nero AAC or WMA). In contrast to Audio CDs that can only be burned on CDs, you can burn these compilations of different audio formats on other disc types – provided a corresponding recorder is installed on your computer. The procedure for compilation methods is identical. You can opt for a single format or a mix of audio formats of your choice. In contrast to data disc, a jukebox disc can display metadata (title, artist, genre, ...) about the audio file.

Nero Express does not convert the audio files when creating a jukebox disc. In other words, MP3 files are burned as MP3 files for example. Most CD players cannot play such discs.

From a technical point of view, a compilation of special audio formats is a data disc. There is no difference between creating a jukebox disc and creating a data disc. Please be sure to select the corresponding entry in the start screen.

See also
- Compilation Screen →12
- Compiling Data Disc →15

5.3 Automatic Music Recognition

With Gracenote MusicID Nero Express can identify music files. So called metadata such as artist, title, and genre are accessed from the Gracenote Media Database and displayed in Nero Express. The identified metadata is written to the music file and is then available.

Identification is possible for single audio files as well as complete original Audio CDs. If the metadata of the Audio CD is not yet included in the database then you can enter it and make it available. The metadata is sent to Gracenote and added into the database.

With Gracenote you can have audio files identified out of any sort of audio compilation. This is particularly useful when audio files are not named or are only partially named. The metadata that is made available by Gracenote is used for the compilation and is written into the audio files. In this way your music collection is correctly tagged with all information.
During the following actions, original Audio CDs can be automatically identified in Nero Express with Gracenote MusicID.

- Copying Audio CD
- Saving Tracks from the Audio CD to Hard Drive

**Gracenote Plug-in**
You will need the Gracenote Plug-in to identify single audio files and to display Album art.
You can obtain the plug-in at [www.nero.com](http://www.nero.com). The plug-in is already included in the full version of Nero Express in Nero 12 or Nero 12 Platinum.

Music recognition technology and related data are provided by Gracenote®. Gracenote is the industry standard in music recognition technology and related content delivery. For more information, please visit [www.gracenote.com](http://www.gracenote.com).

### 5.3.1 Identifying Audio Files
You can have the added audio files in the music compilations identified with Gracenote and access metadata such as artist and title from the Gracenote Media Database.

Some of the functions mentioned here are restricted or not available in the Essentials version. You can always upgrade your Essentials version at [www.nero.com](http://www.nero.com) to get the full version with all the functions.

**Gracenote Plug-in**
You will need the Gracenote Plug-in to identify single audio files and to display Album art.
You can obtain the plug-in at [www.nero.com](http://www.nero.com). The plug-in is already included in the full version of Nero Express in Nero 12 or Nero 12 Platinum.

To do this, proceed as follows:

1. Select the type of compilation to burn a music CD.
   - The compilation screen is displayed.
2. Add audio files from the hard drive to the music compilation.
3. Select one or more audio files in the compilation.
4. Right-click to open the context menu.
5. Select the **Get metadata** entry.
The audio files are analyzed and the required information is sent to Gracenote. The **Edit Meta Data** window is opened. The metadata received by Gracenote is displayed in the **New Info** area.

6. If necessary, edit the metadata, e.g. track number, title, artist, album title, year, and genre.

7. Click the **Apply** button.
   - The **Edit Meta Data** window is closed.
   - The metadata is written into the audio file and accordingly shown in Nero Express. If the **Adjust all file name(s)** check box is selected, the file on hard drive is renamed accordingly (if technically possible).

### 5.4 Copy Audio CDs to Hard Drive

With Nero Express you can save audio files from an Audio CD to the hard drive. In the process, the files are encoded, i.e. converted into a format that the computer can read. The audio file is usually compressed.

The Audio CD can be automatically identified with Gracenote MusicID. So called metadata such as title, genre, and track title are accessed by the Gracenote Media Database and associated to the tracks. If available, Album art is also displayed and associated to the tracks.
That way you have audio files that are accurately and fully named after the encoding process.

Music recognition technology and related data are provided by Gracenote®. Gracenote is the industry standard in music recognition technology and related content delivery. For more information, please visit www.gracenote.com.

Audio files from copy-protected Audio CDs cannot be saved.

The encoding and decoding formats in the Essentials version are limited. You can always upgrade your Essentials version at www.nero.com to get the full version with all the functions.

mp3PRO Plug-in
You will need the mp3PRO Plug-in for unlimited MP3 and mp3PRO encoding/decoding.

The plug-in can be added to Nero 12. You can obtain the plug-in at www.nero.com. The plug-in is already included in the full version.

To save audio files, proceed as follows:

1. Click the Save Audio Tracks button in the extended area of the screen.
   ➔ The Save Audio Tracks to Hard Drive window is opened.

2. Insert your Audio CD into a drive.
   ➔ The disc is being analyzed and the required information is sent to Gracenote. If an exact matching entry is found in the Gracenote Media Database then that metadata will be used and displayed.
   ➔ If several entries are found or the found entry is ambiguous, then the Matches window is opened and the metadata records in question are displayed.

3. Select the metadata record that matches your Audio CD.

4. Click the Send New Data button if none of the metadata records match your Audio CD.
   ➔ The Edit MetaData window is opened.
5. Edit the audio track metadata (Title and Artist) by clicking in the track list.

6. Edit the Audio CD metadata (Album Title, Artist, Year and Genre as well as Album Art) on the right side.

7. Click the Advanced Options button if you want to add additional information.
   - The Gracenote MusicID Information window, which originates from Gracenote, is opened. After entering the additional information, you have to close this window so that the Edit MetaData window is displayed again.

8. Click the Submit Data button.
   - If you have changed the Audio CD's metadata or filled them in for the first time then the changes are sent to Gracenote and entered into the Gracenote Media Database.
   - The Edit MetaData window is closed and the information is passed on to the Save Audio Tracks to Hard Drive window.
9. Select the tracks that you want to save on the hard drive.

10. Click the Output tab.
    ➔ The Output tab is opened.

11. In the File Format drop-down menu, select the target file's audio format.

12. Choose a method for creating the file name in the Mode for Creating File Names drop-down menu.

13. Define other settings according to your preferences.

14. Click the Copy button.
    ➔ Conversion starts. A folder with the album name is created in the desired folder. The audio files are saved in this folder and named according to the method you chose. Metadata that is identified with Gracenote is written into the audio file.
    ➔ You have saved audio files.
5.4.1 Copy Audio CDs to Hard Drive

Define the settings for audio files to be saved on the hard drive in the **Save Audio Tracks to Hard Drive** window. Open the window in the extended area of the start screen by clicking **Save Tracks**.

![Copy Audio CDs to Hard Drive - Source](image)

The following setting options are available:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Source</th>
<th>Specifies settings for the source of the audio data.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>Output</td>
<td>Sets output files configuration options.</td>
</tr>
<tr>
<td>Button</td>
<td>Copy</td>
<td>Starts the copy or save process.</td>
</tr>
</tbody>
</table>

**See also**

- Compiling Audio CDs →22
5.4.1.1 Source Tab

The **Source** tab displays the audio files on the Audio CD. The functions of the control buttons correspond to the familiar control buttons on CD players.

The following setting options are available:

<table>
<thead>
<tr>
<th>Drop-down menu</th>
<th>Source drive</th>
<th>Selects the drive where the Audio CD is inserted.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title Selection List</strong></td>
<td>Displays the tracks on the Audio CD. You can select individual tracks to copy by selecting the respective check box.</td>
<td></td>
</tr>
<tr>
<td><strong>Button Refresh</strong></td>
<td>Sends a new query to the Gracenote Media Database and completes the Audio CD’s metadata including artist, title name, and genre if a matching entry exists in the database.</td>
<td></td>
</tr>
<tr>
<td><strong>Button Edit</strong></td>
<td>Opens the <strong>Edit Meta Data</strong> window. Here, you can edit the Audio CD metadata sent by Gracenote. You can enter the metadata if no entry for your Audio CD exists in the Gracenote Media Database. This metadata is sent to Gracenote, and added to the Gracenote Media Database.</td>
<td></td>
</tr>
<tr>
<td><strong>Input fields Album/Artist/Year</strong></td>
<td>Displays or specifies metadata for the album, artist and year.</td>
<td></td>
</tr>
<tr>
<td><strong>Selection list Genre</strong></td>
<td>Displays or specifies the genre.</td>
<td></td>
</tr>
<tr>
<td><strong>Cover area</strong></td>
<td>Displays Album Art, i.e., the cover of the Audio CD.</td>
<td></td>
</tr>
<tr>
<td><strong>Button Load Cover</strong></td>
<td>Loads an alternative cover from your hard drive.</td>
<td></td>
</tr>
</tbody>
</table>
5.4.1.2 Output Tab

You can define the properties of the audio files to be created on the Output tab.

The following setting options are available:

<table>
<thead>
<tr>
<th>Setting Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input window</td>
<td>Selects the storage location for the output file.</td>
</tr>
<tr>
<td><strong>Output directory</strong></td>
<td></td>
</tr>
<tr>
<td>Button</td>
<td></td>
</tr>
<tr>
<td><strong>Browse</strong></td>
<td>Opens a browser window where you can select a storage location.</td>
</tr>
<tr>
<td>Drop-down menu</td>
<td>Selects the method to be used for creating the name of the output file.</td>
</tr>
<tr>
<td><strong>Mode for creating file name</strong></td>
<td></td>
</tr>
<tr>
<td>Check box</td>
<td>Creates a playlist of the saved audio files. A playlist is a list of the</td>
</tr>
<tr>
<td><strong>Automatically generate a playlist of stored audio tracks</strong></td>
<td>ripped audio files in the right order with the right metadata. It is a very convenient tool – you simply have to select the playlist to add all the audio files in contains to an audio compilation or a playback application.</td>
</tr>
<tr>
<td>Drop-down menu</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Playlist format</strong></td>
<td>Selects a format for the playlist.</td>
</tr>
<tr>
<td><strong>File format</strong></td>
<td>Selects the output audio format for the selected audio file. The selected file format is available as the first entry the next time it is called up. You can choose between Nero AAC Audio, MP3 Audio, WAVE, AIFF, FLAC and Ogg Vorbis.</td>
</tr>
<tr>
<td><strong>Quality</strong></td>
<td>Selects the bitrate for the selected audio file format. If the bit rate is small, less data is transferred. The file is then small, but quality is lower. If the bit rate is high, more data is transferred. The file size is then large, but the quality is high. A value of 128 for MP3 files is near CD quality. For the MP3 Audio file format you can also select if you want to create an MP3 file or an mp3PRO file. Only available if you selected the <strong>Nero AAC Audio</strong> or <strong>MP3 Audio</strong> file format.</td>
</tr>
<tr>
<td><strong>Force compatibility with iPod</strong></td>
<td>Makes Nero AAC Audio available for an iPod. Is only available if you selected the <strong>Nero AAC Audio</strong> output format.</td>
</tr>
<tr>
<td><strong>Disable ID3v2 Unsynchronization</strong></td>
<td>Disables the ID3v2 Unsynchronization during the decoding process. ID3v2 Unsynchronization is a part of the MP3 decoding process. It increases the chance that the MP3 file can be played even with old software or hardware that does not support ID3v2. However, some devices that support ID3v2 do not support ID3v2 Unsynchronization. The display of images or text tags might be corrupt on such devices when playing MP3 files with unsynchronized ID3v2. Select the check box if you have encountered such problems.</td>
</tr>
<tr>
<td><strong>Add Album Art to file if available</strong></td>
<td>Adds Album Art to the files. Album Art works for example as a mini view in the Explorer. Adding Album Art increases the file size. Only available if Album Art is available or chosen for this Audio CD.</td>
</tr>
</tbody>
</table>
6 Video

6.1 Compiling DVD-Videos

With Nero Express you can burn DVDs made up of premastered DVD-Video files from your hard drive. You can show your burned DVDs on almost all DVD players. You can use Nero Express to burn a DVD if the DVD video title, i.e. a complete DVD folder structure, is already available.

In Nero Express it is not possible to convert video files to DVD-Video, an AVCHD video, or a BDMV-Video. Converting video files to DVD-Video, to AVCHD video, or BDMV-Video is possible in Nero Video for example. Nero Video is included in the full version of Nero 12. More information about Nero Video is available on the Web site www.nero.com, and more information about video editing is available in the separate Nero Video manual.

To compile a DVD-Video, proceed as follows:

1. Click the Videos menu icon in the Nero Express start screen.
   ➤ The video options are displayed.

2. Click the DVD-Video Files option.
   ➤ The DVD-Video Files compilation screen is displayed.

3. Click the Add button.
   ➤ The Add files and folders window is opened.

4. Select the DVD-Video files that you would like to add to the compilation and click the Add button.

5. Click the Close button.
   ➤ The DVD-Video files are added to the compilation and are displayed in the compilation screen.
If the DVD-Video files selected are larger than 4483 MB and if a DVD recorder which can burn DVDs with 2 layers (DVD DL) is installed, you can select the DVD9 (8152MB) option in the drop-down menu.

6. Click the Next button.

- You have successfully compiled a DVD-Video and can now burn this compilation.

See also

Compilation Screen → 12

6.2 Compiling Blu-ray Video Disc

With Nero Express you can burn a BDMV-Video disc made up of BDMV (= Blu-ray Movie) files from your hard drive. You can play your burned BDMV-Video on almost all Blu-ray players.

You can use Nero Express to burn a BDMV-Video if the complete folder structure is already available.

In Nero Express it is not possible to convert video files to DVD-Video, an AVCHD video, or a BDMV-Video. Converting video files to DVD-Video, to AVCHD video, or BDMV-Video is possible in Nero Video for example. Nero Video is included in the full version of Nero 12. More information about Nero Video is available on the Web site www.nero.com, and more information about video editing is available in the separate Nero Video manual.

To compile a BDMV-Video disc, proceed as follows:
1. Click the Videos menu icon in the Nero Express start screen.  
   ➔ The video options are displayed.

2. Click the BDMV Files option.  
   ➔ The BDMV Files compilation screen is displayed.

3. Click the Add button.  
   ➔ The Add files and folders window is opened.

4. Select the BD-Video files that you would like to add to the compilation and click the Add button.

5. Click the Close button.  
   ➔ The BD-Video files are added to the compilation and are displayed in the compilation screen.

Files and Folders
The BDMV-Video contains different folders. Only certain files are allowed in an individual folder. If you only have individual files, you must allocate the right files to the specific folder:

- \BDMV\index.bdmv
- \BDMV\MovieObject.bdmv
- \BDMV\PLAYLIST\*.mpls
- \BDMV\CLIPINF\*.clpi
- \BDMV\STREAM\*.m2ts
- \BDMV\AUXDATA\sound.bdmv
- \BDMV\AUXDATA\*.otf
- \BDMV\BDJO\*.bdjo (these files are optional; however, the folder must be avail-
Also, the folders \BDMV\META, \BDMV\JAR and \CERTIFICATE must be available but may remain empty.

If the folder \BDMV\BACKUP is available, it contains a copy of the files index.bdmv, MovieObjects.bdmv and the folders PLAYLIST, CLIPINF and BDJO.

6. Click the **Next** button.

   - You have successfully compiled a BD-Video and can now burn this compilation.

### 6.3 Compiling AVCHD Video Disc

With Nero Express you can burn an AVCHD video disc made up of **AVCHD video files** from your hard drive or camcorder. The AVCHD video disc can be burned to a DVD as usual, or to a Blu-ray Disc. Burning to a Blu-ray Disc has the benefit that it offers more space than a DVD.

AVCHD video on DVD is compatible to the specification of a Blu-ray Disc. However, playback is not guaranteed on all Blu-ray players.

You can use Nero Express to burn an AVCHD video disc if the complete folder structure including premastered files is already available.

In Nero Express it is not possible to convert video files to DVD-Video, an AVCHD video, or a BDMV-Video. Converting video files to DVD-Video, to AVCHD video, or BDMV-Video is possible in Nero Video for example. Nero Video is included in the full version of Nero 12. More information about Nero Video is available on the Web site [www.nero.com](http://www.nero.com), and more information about video editing is available in the separate Nero Video manual.

To compile an AVCHD video disc, proceed as follows:

1. Click the **Videos** menu icon in the Nero Express start screen.
   
   ➔ The video options are displayed.

2. Click the **AVCHD(TM) Files (BD)** or **AVCHD(TM) Files (DVD)** option.
   
   ➔ The **AVCHD(TM) Files** compilation screen is displayed.
3. Click the Add button.
   ➞ The Add files and folders window is opened.

4. Select the AVCHD video files that you would like to add to the compilation and click the Add button.

5. Click the Close button.
   ➞ The AVCHD video files are added to the compilation and are displayed in the compilation screen.

6. Click the Next button.
   ➞ You have successfully compiled an AVCHD video disc and can now burn this compilation.
7 Loading a Disc Image or Saved Project

With Nero Express you can burn a disc from a disc image or compilation that you have previously saved on the hard drive.

To load an image file or a saved compilation for the burn process, proceed as follows:

1. Click the Image, Project, Copy menu icon in the Nero Express start screen.
   ➞ The copy and disc image options are displayed.

2. Click the Disc Image or Saved Project option.
   ➞ The Open dialog window is opened.

3. Select the image file (*.nrg, e.g.) or saved compilation you want and click the Open button.
   ➞ The selected file loads and the Final Burn Settings screen is displayed.
      ➞ You have successfully loaded the image file or compilation and can now burn it.
8 LightScribe

Using Nero Express and a LightScribe recorder you can create or load labels that you can burn onto the label side of CDs/DVDs in the LightScribe recorder. The function is available as a separate Print LightScribe Label option in the start screen or can be integrated as an intermediate step into the creation and burn process of a project.

This function is only available in the full version of Nero Express that is included in Nero 12. You can always upgrade at [www.nero.com](http://www.nero.com) to get the full version with all the functions.

This function is only available in recorders that support LightScribe technology.

See also

LightScribe Settings → 78

8.1 Printing LightScribe Label

To create and print a LightScribe label for your CD/DVD, proceed as follows:

1. Select the LightScribe recorder you want to use in the Recorder section of the extended area in the start screen.
2. Insert a blank LightScribe disc into the LightScribe recorder with the label side facing down.

The Print LightScribe Label menu icon in the Nero Express start screen is displayed.
3. Click the **Print LightScribe Label** menu icon.
   ➔ The **Print LightScribe Label** option is displayed.

4. Click the **Print LightScribe Label** option.
   ➔ The **Disc Label** screen is displayed.

5. Create a label according to your requirements.
The interface in the **Disc Label** screen works on the same principle as Nero CoverDesigner. Basically, it is irrelevant whether you print the label on paper or directly onto an appropriate disc. Please see the separate Nero CoverDesigner user manual for full instructions on how to make professional looking covers and labels.

6. Click the **Next** button.
   - The **LightScribe Print Properties** screen is displayed.

7. Add to the required values in the input fields and enable the option button for the desired print quality.

8. Click the **Print** button.
   - The printing process begins. You can follow the process status in the status bar. As soon as printing is finished, the **Nero – LightScribe** dialog appears and displays a message about the result of the printing process.

9. Click the **OK** button.

10. Click the **Next** button in the **LightScribe Print Properties** screen.
    - You have successfully created and printed a LightScribe label according to your requirements and can now continue by selecting another option from the final screen or by exiting Nero Express.
    - It is possible to burn the label several times to the same LightScribe disc. The printed labels will be aligned. This darkens the label and often improves the quality. It is also possible to extend the label with new elements in an additional burn process. Note to save the created label if you want to use it once again.

### Burning LightScribe label Within the Compilation

To integrate the creating and burning of a LightScribe label in your compilation project, enable the **Always print LightScribe label** check box in the **Options**. The **Disc Label** screen will then be displayed after you have compiled your project (as long as the LightScribe recorder is selected). The label print process will be executed after burning of the data side.

See also

- LightScribe Print Properties Window → 47
- Final Screen → 66
- LightScribe Settings → 78

### 8.2 LightScribe Print Properties Window

You can customize the print properties of your LightScribe label to suit your requirements in the **LightScribe Print Properties** window.
The following options are available:

<table>
<thead>
<tr>
<th>Area</th>
<th>Print contrast</th>
<th>Adjusts the desired print quality. This option button is set to Normal by default.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input field</td>
<td>Number of copies</td>
<td>Defines the number of copies you require.</td>
</tr>
<tr>
<td>Drop-down menu</td>
<td>Drive</td>
<td>Defines the desired recorder. Available only if multiple LightScribe recorders are available.</td>
</tr>
<tr>
<td>Check box</td>
<td>Automatically shut down the PC when done</td>
<td>Shuts down the computer after the label has been printed (if possible).</td>
</tr>
<tr>
<td>Button</td>
<td>Print</td>
<td>Starts printing the label.</td>
</tr>
<tr>
<td>Button</td>
<td>Preview</td>
<td>Opens the <strong>LightScribe Print Preview</strong> dialog box. A print preview of the label is displayed here.</td>
</tr>
</tbody>
</table>
9 **Labelflash**

If you have a [Labelflash](#) recorder, you can print a [label](#) on the label and/or data side of the Labelflash DVD. A Labelflash DVD has a special layer between the top and bottom layers; this layer can be heated by the laser in the recorder so that images and text can be printed on the DVD.

This function is only available in the full version of Nero Express that is included in Nero 12. You can always upgrade at [www.nero.com](http://www.nero.com) to get the full version with all the functions.

The interface in the [Burn Label](#) screen works on the same principle as Nero CoverDesigner. Basically, it is irrelevant whether you print the label on paper or directly onto an appropriate disc. Please see the separate Nero CoverDesigner user manual for full instructions on how to make professional looking covers and labels.

This feature is only available in recorders that support Labelflash technology.

9.1 **Burn Label Window**

In the [Burn Label](#) window you can create or load a label and write it on a Labelflash DVD. Information on the selected printing quality and rotation speed is displayed on the right-hand side of the screen. Under [Disc type](#) you can see whether the blank disc has been inserted with the label or data side. Either the Labelflash or the DiscT@2 logo is displayed in the [Burn Label](#) window depending on which side is inserted.
The following configuration options are available in the **Burn Label** window:

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Inner Radius</strong></td>
<td>Input field that defines the distance between the label and the inner edge.</td>
</tr>
<tr>
<td><strong>Width</strong></td>
<td>Input field that defines the width of the print area.</td>
</tr>
<tr>
<td><strong>Change</strong></td>
<td>Button that opens the <strong>Labelflash Print Properties</strong> window. This is where you can change the printing quality and the contrast level and display the changes made directly in the print preview.</td>
</tr>
<tr>
<td><strong>Preview</strong></td>
<td>Button that opens the <strong>Print Preview</strong> window that shows how the label should appear on the Labelflash disc.</td>
</tr>
<tr>
<td><strong>Label templates</strong></td>
<td>Selection list that contains a selection of different templates for designing the label. You can continue to edit and customize a selected template.</td>
</tr>
</tbody>
</table>
9.2 Printing Labelflash Labels and DiskT@2

Basically, it is irrelevant whether you print on the label or the data side when creating labels. The label is actually printed outside the normal burn process.

You can print on the label side of the DVD at any time. We recommend that you print on the data side first when you have burned the compilation. It is not possible to burn data on a printed data side. When you insert a DVD on which data has already been burned, Nero Express automatically identifies the space that is still available on the data side and on which you can print.

To print a Labelflash label on the label side or a DiskT@2 on the data side of your DVD, proceed as follows:

1. If you want to print a Labelflash label on the label side, insert a blank Labelflash disc into the recorder with the label side facing down.
   → The Burn Label window is opened with the Labelflash logo.

2. If you want to print a DiskT@2 on the data side, insert a blank Labelflash disc with the data side facing down in the recorder.
   → The Burn Label window is opened with the DiskT@2 logo.

3. Create a label according to your requirements or open a label that you have already created with Nero CoverDesigner.

   The interface in the Burn Label window and creation of a label work on the same principle as Nero CoverDesigner. See the separate Nero CoverDesigner manual for full instructions on how to create professional looking covers and labels.

4. If you want to change the area in which the label is printed, change the print area accordingly using the input fields Inner Radius and Width.

5. If you want to view or change the print properties:
   1. Click the Change button.
1. If you want to change the printing quality, select a quality level from the **Print quality profile** drop-down menu.

2. If you select the **User defined** entry from the **Print quality profile** drop-down menu, you can change the contrast level and the rotation speed.

3. Click the **OK** button.

   - The **Labelflash Print Properties** window is closed and the changes are accepted.

4. Click the **Burn** button.

   - The labeling procedure starts and the **Labelflash - printing** or **DiscT@2 - printing** window is opened. The window shows the estimated printing time and the print progress. When printing is complete, a message window is opened informing about the successful print process.

5. Click the **OK** button.

   - The message window is closed and the disc ejected.

   - You have successfully printed a label.
10 Burn Compilation

10.1 Choice of Burner

If multiple recorders are installed, you can select the recorder that you want to use for burning from the Recorder drop-down menu. Immediately before burning a project, you can change the recorder you selected again in the Final Burn Settings window.

**Labelflash recorder**
If a Labelflash recorder is installed on your computer, you can select it to create and print Labelflash DVD labels in Nero Express. The function is available as a separate Burn Label menu icon in the extended area of the start window.

**LightScribe recorder**
If a LightScribe recorder is installed on your computer, you can select it to create and print LightScribe CD/DVD labels in Nero Express. The feature is available as a separate Print LightScribe Label option in the start screen or can be integrated as an intermediate step into the creation and burn process of a project.

Burn functions are limited in Nero Express Essentials. You can always upgrade at www.nero.com to get the full version with all the functions.

In addition to the installed recorders, Nero Image Recorder is also available in Nero Express. Nero Image Recorder can be used to create and save an image file to burn later. In order to use Nero Image Recorder, you can select the Use Nero Image Recorder check box in the extended area of the start screen.

Please note that Nero Image Recorder can only be activated in the extended area of the start screen.

The Image Recorder is also suitable for creating an image of a disc type not supported by the connected recorder. For example, you can therefore create a DVD image without having installed a DVD recorder. You can then write the image to a disc at any time.

You can find more information on Blu-ray support at www.nero.com/link.php?topic_id=416.
10.2 Starting the Burn Process

To select one of the available recorders, to define the burn settings for your project according to your requirements, and to start the burn process, proceed as follows:

1. Compile a project of your choice.
2. Click the Next button.
   - The Final Burn Settings screen is displayed.
3. Insert a suitable blank disc in the selected drive.
4. Select the recorder you want from the Current recorder drop-down menu.
5. Add to the desired values in the input fields as necessary and select the required check boxes.
6. Add to the desired settings in the extended area.
7. Click the Burn button.
   - The Burn Process screen is displayed and the burn process starts. You can follow the process status in the status bar.
   - If the SecurDisc Surface Scan check box is selected, the SecurDisc Surface Scan Results window is opened.
   - Nero Express starts with the surface scan. The results are displayed in realtime.
   - When the burn process has finished, a message window is opened.
8. Click the OK button.
9. If you would like to save a log of the burn process, click the Save button.
10. Click the Next button.
    - You have successfully burned a project and can now continue by selecting another option from the final screen or by exiting Nero Express.

10.3 Creating an Image File

With Nero Express and the Image Recorder you can create disc images from every compilation. The NRG image file format can always be selected whereas the ISO image file format can only be selected from certain compilation types. Nero Express only enables the possible image file formats.

The NRG image file format was developed by Nero. In contrast to ISO, NRG can be created from every disc and compilation type. This means that even Audio CDs or multisession discs can be saved as an NRG image file.

This function is only available in the full version. You can always upgrade your Essentials version at www.nero.com to get the full version with all the functions.
Nero Image Recorder must be activated before it appears in the drop-down menu.

To set the burn settings according to your requirements and to save your project as an image file to the hard drive using the Image Recorder, proceed as follows:

1. Compile a project of your choice.
   ➤ The Final Burn Settings screen is opened.

2. Select the Image Recorder option from the Current Recorder drop-down menu.

3. Add to the required values in the input fields.

4. Add to the required settings in the extended area as necessary.

5. Click the Burn button.
   ➤ The Burning Process screen is displayed and the Save Image File dialog box is opened.

6. Enter a name for your image file in the File Name input field.

7. Select the desired storage location in the navigation tree and click the Save button.
   ➤ The burn or save process starts. You can follow the process status in the status bar. As soon as the burn or save process is finished, a window is opened and displays a message about the result of the burn process.

8. Click the OK button.

9. If you would like to save a log of the burn process, click the Save button.

10. Click the Next button.
You have successfully saved a project with Nero Image Recorder and can now continue by selecting another option from the final screen or by exiting Nero Express.

10.4 Final Burn Settings Screen

In the Final Burn Settings screen, you can define the burn settings to suit your requirements, use Nero Image Recorder to save a project to the hard drive as an image file or start the burn process.

The following configuration options are available in the Final Burn Settings screen:

<table>
<thead>
<tr>
<th>Button</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opens the Recorder Information window. You will find additional information here on the selected recorder and the media types that can be burned using it. Additional options can be enabled/disabled. In some recorders, you can change the Book Type settings. Not available for Audio CDs.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Input field</th>
<th>Disc name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defines the name of the CD/DVD. Not available for Audio CDs.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Input field</th>
<th>Title (CD TEXT)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defines the title of the Audio CD if CD Text is supported. Available for Audio CDs only. Only Latin characters can be displayed as CD Text. CD Text can only be written in disc-at-once mode.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Input field</th>
<th>Artist (CD TEXT)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defines the artist on the Audio CD if CD Text is supported. Available for Audio CDs only. Only Latin characters can be displayed as CD Text. CD Text can only be written in disc-at-once mode.</td>
<td></td>
</tr>
</tbody>
</table>
10.4.1 Extended Area (Burn Settings)

You can access additional burn settings in the extended area of the Final Burn Settings screen by clicking the button in the left margin of the window.

The following setting options are available:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saves the active project</td>
<td>Opens the Save As dialog box. You can save your compilation here.</td>
</tr>
<tr>
<td>Selection list</td>
<td>Writing speed</td>
</tr>
<tr>
<td></td>
<td>Defines the speed at which the disc is burned. Only the burn speeds that are supported by the selected recorder are displayed. Not available when saving with Nero Image Recorder.</td>
</tr>
<tr>
<td>Selection list</td>
<td>Write method</td>
</tr>
<tr>
<td></td>
<td>Defines the Disc/Session-at-once or Track-at-once write method.</td>
</tr>
<tr>
<td></td>
<td>Using the disc-at-once method the entire disc can be burned without the write laser having to stop. With the track-at-once method the laser turns off after each track. Available for CD compilations only. By default DVDs are burned using the disc-at-once method.</td>
</tr>
<tr>
<td>Check box</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Determine maximum transfer rate</strong></td>
<td>Checks how fast the compiled data can be accessed and reduces the selected writing speed if necessary. This prevents a buffer underrun. Recorders with a feature to prevent buffer underruns do not require a speed test. Current recorders mostly have such a feature. Not available when saving with Nero Image Recorder.</td>
</tr>
<tr>
<td><strong>Simulation</strong></td>
<td>Performs all steps in the burn process without using the laser beam. We recommend running a simulation if you are decompressing data before burning, e.g. when burning an Audio CD from MP3 files. You can assume that if simulation is successful, the burn process will also be successful. Not available when saving with Nero Image Recorder.</td>
</tr>
<tr>
<td><strong>Write</strong></td>
<td>Starts the actual physical burn process (e.g. after a simulation). This check box is selected by default.</td>
</tr>
<tr>
<td><strong>Automatically shut down the PC when done</strong></td>
<td>Automatically shuts down the PC after the burn process has ended.</td>
</tr>
<tr>
<td>*<em>Remove silence at end of <em>.cda tracks</em></em></td>
<td>Removes silence from the end of an audio file. This check box is selected by default. Audio data is stored in blocks even if you do not always finish at the end of a block limit. The last block is filled with silence when needed. To avoid unwanted effects set the pause length to 0 when clearing this check box (to set the pause length see Track Properties Tab→24). Available for Audio CDs only.</td>
</tr>
<tr>
<td><strong>Increase compatibility of MPEG-4 video files with MPEG-4 compliant DVD players</strong></td>
<td>If the check box is selected, Nero Express looks for FourCC codes in AVI files during the burn process and replaces them. The original files are not modified. The compatibility of MPEG-4 video files (&quot;DIVX&quot;) with MPEG-4 compliant DVD players can be increased. Only available if your project includes videos in AVI format.</td>
</tr>
</tbody>
</table>

---

Audio CDs should always be burned using the disc-at-once method. This entry is selected by default.
11 Copying a Disc

11.1 Methods of Copying

Nero Express can be used for copying discs. There are two methods for this:

- On-the-fly
- Copy Over Image

Each method has advantages and disadvantages which will depend on your requirements.

11.1.1 On-the-fly Copying

When using the on-the-fly method, insert the original disc into a drive and a recordable disc into the drive. The original disc in the drive is copied immediately without any time delay to the blank disc in the recorder. The on-the-fly method allows you to copy discs very quickly, and does not require any additional space on the disc.

In order to be able to use the on-the-fly method, you will need at least two drives: one for reading the disc and a disc burner for writing. The following requirements apply to the read drive and disc burner:

- The disc burner must feature buffer underrun protection, or the drive must be capable of delivering the data sufficiently quickly. The read speed should be at least twice as fast as the write speed.
- The read drive must be capable of delivering information on the number and type of sessions, otherwise Nero Express may not be able to produce an exact copy.

If you want to copy Audio CDs, we recommend the copy image method because the quality of the read audio files can suffer depending on the drive.

11.1.2 Copy Over Image

With the copy over image method, an image of the original disc is saved to a file first. The image file is then burned to a blank disc. Copying using copy over image takes longer, but it often produces better results.

You must have sufficient storage space to use the copy over image method.

The copy over image method is particularly suitable in the following situations:

- Only one drive is available.
- You would like to make several copies of the same disc.
- You think it likely that read errors may have occurred on the source CD (for example because it is scratched).
- You attach importance to the best possible reproduction (particularly in relation to index positions and the quality of Audio CDs).
11.2 Copying a Disc

With Nero Express you can copy a disc. That means you make an exact copy of a source disc and burn it to a target disc. If your source disc is an Audio CD, for instance, your copy will be an Audio CD as well. Depending on your installed burner, you can copy CDs, DVDs or Blu-ray Discs. The target disc must be the same disc type as the source disc - you can copy a DVD only to a DVD, for example. In any case, Nero Express will give you a message when the disc type do not fit.

If you are not in possession of the copyright for the relevant disc and do not have authorization from the owner of the copyright, unauthorized copying of discs violates national and international legislation.

Some discs are copy-protected and cannot be copied. If you are not sure whether your disc can be copied, activate simulation before commencing the actual physical burn process.

To copy a disc, proceed as follows:

1. Click the **Image, Project, Copy** menu icon in the Nero Express start screen.
   ➔ The corresponding copy options are displayed.

2. Click the **Copy Disc** option.
   ➔ The **Select source and destination** screen is displayed.

3. Make the desired settings in this screen and, if required, in the extended area of the window.
4. If you want to copy discs using the **Image Copy** method:
   1. Clear the **Quick copy** box.
   2. Insert the disc that you want to copy into the recorder.

5. If you want to copy discs using the **on-the-fly** method:
   1. Select the **Quick copy** check box.
   2. Select the **Source drive** and the **Destination drive**.
   3. Insert the disc that you want to copy into the selected drive.
   4. Insert a blank disc into the target drive.

6. Click the **Copy** button.
   - If you are copying via the drive, the copy process starts. If you are using Nero Image Recorder, the **Save Image File** window is opened.

7. Enter a name for your image file in the **File Name** input field.

8. Select the relevant storage location in the **Save to** navigation tree and click the **Save** button.
   - The copy and/or save process starts. You can follow the process status in the status bar. If you are using a single drive for copying, you will be prompted to remove the source disc and to insert a suitable blank disc after the image file has been written. The burn process then starts automatically.

9. Click the **Next** button.
   - You have successfully copied a disc and can now continue by selecting another option from the final screen or by closing Nero Express.

**See also**

[Final Screen → 66]
11.3 Copy Settings

The following configuration options are available in the **Source and destination** screen:

<table>
<thead>
<tr>
<th>Selection list</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Source drive</strong></td>
<td>Defines the drive from which the source information is read. Insert the disc that you want to copy into the drive.</td>
</tr>
<tr>
<td><strong>Destination drive</strong></td>
<td>Defines the destination drive. Insert a blank disc into this drive.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Button</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Info</strong></td>
<td>Opens the <strong>Recorder Information</strong> window. This contains information on the selected destination drive.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Check box</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Quick copy</strong></td>
<td>Enables direct copying from the source to the destination drive. Data is not buffered on the hard drive during this process. The option <strong>On-the-fly</strong> is only available if there are at least two drives connected (does not apply for Nero Image Recorder). If this check box is not selected, an image file will be created first, which is then burned.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Selection list</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Write speed</strong></td>
<td>Defines the speed at which the disc is burned. Only the burn speeds that are supported by the selected recorder are displayed. Not available for Nero Image Recorder.</td>
</tr>
</tbody>
</table>
### Copying a Disc

#### Input field

**Number of copies**
- Defines the number of copies you require.

#### Check box

**Verify data on disc after burning**
- Verifies whether the burned data is identical to the original data.
- Not available for Nero Image Recorder.

**Display field / Button**

**Image file**
- Defines the folder where the image file is stored. You can change the name of the image file and target folder.
- Not available for Nero Image Recorder.

The following configuration options are available in the extended area:

#### Check box

**Read all subchannel data**
- Reads all subchannel data during copying. Subchannel data is used to save additional information, e.g. CD Text or the lyrics of a karaoke CD. Select this check box when copying an Audio CD or a karaoke CD.
- The burner has to be capable of reading all the subchannel data.

**Determine maximum transfer rate**
- Checks how fast the compiled data can be accessed and reduces the selected writing speed if necessary. This prevents a buffer underrun.
- Recorders with a feature to prevent buffer underruns do not require a speed test. Current recorders mostly have such a feature.
- Not available when saving with Nero Image Recorder.

**Simulation**
- Performs all steps in the burn process without using the laser beam. You can assume that if simulation is successful, the burn process will also be successful.
- Not available for Nero Image Recorder.

**Write**
- Starts the actual physical burn process (e.g. after a simulation).
  - This check box is selected by default.

**Automatically shut down the PC when done**
- Automatically shuts down the PC after the burn process has ended.
12 Erase Rewritable Disc Window

Nero Express can be used to erase rewritable discs, i.e. discs with the RW specification, as long as your recorder supports this feature. Two erase methods are available for this purpose:

Quick erasing does not remove the data physically from the disc, but instead only makes it inaccessible by erasing the references to existing content. The data can be restored!

Full erasing removes the data from the disc by overwriting it with zeros. The contents cannot be restored with conventional methods. Repeated full erasing increases the probability that third parties will not be able to reconstruct the contents.

The following configuration options are available in the Erase Rewritable Disc window:

<table>
<thead>
<tr>
<th>Selection list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select recorder</strong></td>
<td>Defines the desired recorder.</td>
</tr>
<tr>
<td><strong>Check box</strong></td>
<td>Simultaneously erases CDs/DVDs in multiple recorders.</td>
</tr>
<tr>
<td><strong>Select the erase method to be used</strong></td>
<td>Defines the erase method. Two options are available: The <strong>Quick-erase rewritable disc</strong> method does not physically erase all data from the disc, but only the references to the contents. The disc will appear to be empty even though the data is still physically available. Erasing a disc using this method takes between one and two minutes.</td>
</tr>
</tbody>
</table>
The **Full-erase rewritable disc** method physically erases all data from the disc. The contents cannot be restored with conventional methods. Repeated full erasing increases the probability that third parties will not be able to reconstruct the contents. Erasing the disc using this method takes longer than the other method, depending on the type of disc involved.

<table>
<thead>
<tr>
<th>Selection list</th>
<th>Defines the erase speed.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Erase speed</strong></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Button</th>
<th>Starts the erase process.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Erase</strong></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Button</th>
<th>Cancels the action and closes the window.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cancel</strong></td>
<td></td>
</tr>
</tbody>
</table>
13 Final Screen

Once you have successfully concluded the burn or save process with Nero Express, the final screen is displayed with the options **Burn same project again**, **New project**, and **Save Project**. You can select one of these options to continue working with Nero Express or you can click the **X** button to exit the program.

The following setting options are available

<table>
<thead>
<tr>
<th>Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Burn the same project again</td>
<td>Returns to the Final Burn Settings screen. You can burn the same project again with the same or different settings.</td>
</tr>
<tr>
<td>New project</td>
<td>Opens the Nero Express start screen. You can create a new project here.</td>
</tr>
<tr>
<td>Save project</td>
<td>Opens the Save As window. You can save the current project if you want to access it again later.</td>
</tr>
<tr>
<td>Nero CoverDesigner</td>
<td>Opens Nero CoverDesigner. Please see the separate Nero CoverDesigner user manual for full instructions on how to make professional looking covers and labels.</td>
</tr>
<tr>
<td>Burn Labelflash Label</td>
<td>Opens the Burn Label window in order to create and burn a Labelflash label. Only available if a Labelflash recorder is connected.</td>
</tr>
</tbody>
</table>
14 About Nero SecurDisc Viewer

Nero SecurDisc Viewer is a standalone application that is part of the SecurDisc technology platform. SecurDisc is a technology developed by Nero and HLDS to create discs with special protection properties. No special hardware is needed.

Nero SecurDisc Viewer is available as a free download at www.securdisc.net or www.nero.com and is also included automatically in a SecurDisc disc that is burned with Nero Burning ROM or Nero Express.

Discs that are created with Nero and the SecurDisc compilation type include data integrity and reconstruction. Additionally the data on the SecurDisc disc can be protected against unauthorized access by using a password. The data can also be digitally signed. Nero SecurDisc Viewer allows you to copy the protected data to your hard drive and to check the security of the data.

💡 More information on SecurDisc technology can be found at www.securdisc.net.

14.1 Starting Nero SecurDisc Viewer

Nero SecurDisc Viewer is included automatically in a SecurDisc disc that is burned with Nero Burning ROM or Nero Express. Insert the SecurDisc disc in a drive to open Nero SecurDisc Viewer automatically.

Nero SecurDisc Viewer can also be opened by double-clicking the NeroSecurDiscViewer.exe file. This file can either be found on the SecurDisc disc or it can be downloaded from www.securdisc.net or www.nero.com.
14.2 Copying Data to Hard Drive

With Nero SecurDisc Viewer you can copy the files from the SecurDisc disc to your hard drive. If the files have been protected against unauthorized access, you can insert the password here.

Proceed as follows:

1. Select the check boxes of the files you want to copy to the hard drive.

2. Click the Save to button.
   - If data on the SecurDisc disc is password-protected, the Password Protection window is opened.

3. Enter the password in the text box and click the Apply button.
4. Select the required folder and click the **OK** button.

The selected files are copied to the selected folder.

### 14.3 Checking Data Integrity

Nero SecurDisc Viewer can be used to check the data integrity of a SecurDisc disc by using the checksum feature. The data integrity check warns you if the data on a disc is at risk of disc decay so that you have time to back it up to another disc.

Proceed as follows:

1. Click the **Integrity** button.

As soon as the integrity check is finished, a message is displayed to notify you about the result of the check.

### 14.4 Checking Signature

With Nero SecurDisc Viewer you can verify the authenticity of the SecurDisc disc if it is digitally signed. You need the public key from the distributor of the SecurDisc disc for this pur-
pose. By checking the public key, Nero SecurDisc Viewer is able to confirm that the data is authentic and has not been manipulated.

Proceed as follows:

1. Click the **Signature** button.
   - An explorer window is opened.

2. Select the public key (*.bpk) which the SecurDisc disc is signed with.

   **Public key**
   The creator of the SecurDisc disc has also created or selected the public key for the disc. The key is to be distributed by the creator of the disc, too.

3. Click the **OK** button.
   - The explorer window is closed and the **Check** window is opened.
   - The signature is checked. You can follow the progress with the status bar and the displayed messages.
     - As soon as the copy process is finished, a message is displayed to notify you about the result of the check.
15 Nero MediaBrowser

Nero MediaBrowser is a tool which you can use to easily find, view and access media files and add them to your project.

More precisely, with Nero MediaBrowser you can access a media library which contains all your media files that were indexed by Nero Kwik Media. Nero MediaBrowser is designed to be accessed in several Nero applications.

Nero MediaBrowser and the media library come with Nero Kwik Media and are installed together. You will find further information in the Nero Kwik Media manual.

Nero MediaBrowser can be opened via the icon. Although Nero MediaBrowser can be moved freely around your desktop, it is part of Nero Express.

Nero MediaBrowser displays only media files which can actually be used in the relevant Nero Express project. To add media files to your project, select the media files in Nero MediaBrowser and click the Add button.
The browsing task bar is the starting point for browsing Nero MediaBrowser. The categories (Photos & Videos, and Music) are the same as featured in Nero Kwik Media. Each of the categories offers a search bar. It is only possible to search within one category at the same time. When one of the categories is clicked, the corresponding browsing area is displayed below.

There are different views available for each category: Clicking one of the entries in the upper part of the list (for example Timeline) displays the same view as when clicking the corresponding tabs in Nero Kwik Media. Clicking one of the collections in the lower part of the list displays the collection contents made within Nero Kwik Media. When one of the list items is clicked in Nero MediaBrowser, the corresponding content is displayed in the content area below.

The same scroll bar as in Nero Kwik Media is used. This is either the standard scroll bar or the dynamic scroll bar.

The following views are available for the Photos & Videos category:

<table>
<thead>
<tr>
<th>Entry</th>
<th>Displays all photos and videos sorted in chronological order by creation date.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timeline</td>
<td>Refers to Timeline in the upper task bar of Nero Kwik Media.</td>
</tr>
<tr>
<td>Faces</td>
<td>Displays all photos in which faces of persons have been detected and named listed in alphabetical order. Unconfirmed or unnamed faces are not displayed. Faces are grouped into stacks; you can access one of the stacks by double clicking it.</td>
</tr>
<tr>
<td>Refers to Faces</td>
<td>in the upper task bar of Nero Kwik Media.</td>
</tr>
<tr>
<td>Find</td>
<td>Displays all existing tags enabling you to create a query.</td>
</tr>
<tr>
<td>Collections</td>
<td>Refers to Find in the upper task bar of Nero Kwik Media.</td>
</tr>
<tr>
<td>Marked / Rated</td>
<td>Displays the currently marked or rated content.</td>
</tr>
<tr>
<td>Refers to Marked / Rated</td>
<td>in the sidebar of Nero Kwik Media.</td>
</tr>
<tr>
<td>Recently added / Recently modified</td>
<td>Displays the recently added or modified content.</td>
</tr>
<tr>
<td>Refers to Recently added / Recently modified</td>
<td>in the sidebar of Nero Kwik Media.</td>
</tr>
<tr>
<td>Album</td>
<td>Displays the content of smart albums and user generated albums.</td>
</tr>
<tr>
<td>Refers to Photo &amp; Video Albums in the sidebar of Nero Kwik Media.</td>
<td></td>
</tr>
<tr>
<td>Person group</td>
<td>Displays the content of user generated person groups. You can switch between full photo and faces only view with the icon.</td>
</tr>
<tr>
<td>Refers to Faces</td>
<td>in the sidebar of Nero Kwik Media.</td>
</tr>
</tbody>
</table>
The following views are available for the **Music** category:

<table>
<thead>
<tr>
<th>Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Albums</strong></td>
<td>Displays all audio tracks sorted in alphabetical order by album. Refers to <strong>Albums</strong> in the upper task bar of Nero Kwik Media.</td>
</tr>
<tr>
<td><strong>Artists</strong></td>
<td>Displays all audio tracks sorted in alphabetical order by artist. Refers to <strong>Artists</strong> in the upper task bar of Nero Kwik Media.</td>
</tr>
<tr>
<td><strong>Genres</strong></td>
<td>Displays all audio tracks sorted in alphabetical order by genre. Refers to <strong>Genres</strong> in the upper task bar of Nero Kwik Media.</td>
</tr>
<tr>
<td><strong>Titles</strong></td>
<td>Displays all audio tracks sorted in alphabetical order by title. Refers to <strong>Titles</strong> in the upper task bar of Nero Kwik Media.</td>
</tr>
<tr>
<td><strong>Marked / Rated</strong></td>
<td>Displays the currently marked or rated content. Refers to <strong>Marked / Rated</strong> in the sidebar of Nero Kwik Media.</td>
</tr>
<tr>
<td><strong>Recently added / Recently played</strong></td>
<td>Displays the recently added or played content. Refers to <strong>Recently added / Recently modified</strong> in the sidebar of Nero Kwik Media.</td>
</tr>
<tr>
<td><strong>Playlist</strong></td>
<td>Displays the content of user generated playlists. Refers to <strong>Playlist</strong> in the sidebar of Nero Kwik Media.</td>
</tr>
</tbody>
</table>

The **Options** window is opened when you click the button on the upper task bar. The options refer directly to Nero Kwik Media. The following setting option is displayed:

**Library**

- All monitored folders are displayed in the respective **Watched folders or drives** area. If you want to add additional media folders, click the **Add Manually** button and select the desired folder from the navigation tree. Click the **Add Automatically** button to have Nero Kwik Media perform a search for new media folders on your computer. To delete a folder from the application's watchlist, hover your mouse pointer over the listed folder and click the **X** button.

  You can also just drag files or folders to Nero Kwik Media. A window automatically opens and asks if you want to add the folder(s) to the library.

  In the **Other Libraries** area you can select to list your external playlists (such as iTunes) as entries in the navigation tree of Nero Kwik Media.
16 Configuration Options
You can define options for working with Nero Express in the Options window.

Some of the functions mentioned here are only available in the full version. You can always upgrade your Essentials version at www.nero.com to get the full version with all the functions.

Options Window

The following tabs are available:

<table>
<thead>
<tr>
<th>Compilation</th>
<th>Contains options for the compilation and the selection screen.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cache</td>
<td>Contains options for the cache.</td>
</tr>
<tr>
<td>Font</td>
<td>Contains selection options for the font.</td>
</tr>
</tbody>
</table>
Configuration Options

<table>
<thead>
<tr>
<th>Sounds</th>
<th>Contains selection options for sounds in connection with burn tasks.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expert Features</td>
<td>Contains options for configuring overburning and burning. We recommend that you retain the default settings.</td>
</tr>
<tr>
<td>Database</td>
<td>Selects the default naming method for audio files to be saved from an Audio CD to the hard drive.</td>
</tr>
<tr>
<td>Ultrabuffer</td>
<td>Defines the size of the RAM buffer.</td>
</tr>
<tr>
<td>Misc.</td>
<td>Contains options for configuring compilations, burning, the database, the user interface, as well as advanced settings.</td>
</tr>
<tr>
<td>LightScribe</td>
<td>Contains options for configuring LightScribe recorders such as the print contrast (quality), default drive, and default template. This tab is only available if a LightScribe recorder has been installed.</td>
</tr>
</tbody>
</table>

16.1 Compilation Settings

The following configuration options are available on the Compilation tab:

<table>
<thead>
<tr>
<th>Check box</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remember name of last used disc</strong></td>
<td>Uses the Disc name of the last compilation for a new compilation. If the check box is cleared, the Disc name is set to New for a new compilation.</td>
</tr>
<tr>
<td><strong>Clear archive bits of written files during ISO refresh</strong></td>
<td>Clears the archive bit of the source file (e.g. from the hard disk) as soon as the burn process has finished. Clearing of the archive bit is of informational value and indicates that this file has been archived. If this check box is deactivated, the archive bit of the file remains unchanged.</td>
</tr>
<tr>
<td><strong>Allow semicolons in Joliet names</strong></td>
<td>Allows the use of semicolons in addition to standard uppercase and lowercase letters and Unicode characters in file names in the Joliet file system.</td>
</tr>
<tr>
<td><strong>Show original path with ISO compilation</strong></td>
<td>Lists the full path of the added files in the compilation screen in the Source column.</td>
</tr>
</tbody>
</table>
16.2 Cache Settings

The following configuration options are available on the **Cache** tab:

<table>
<thead>
<tr>
<th>Input field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Path for cache</strong></td>
<td>Displays the path of the Cache memory. You can enter the path manually or select the path in the browser window.</td>
</tr>
<tr>
<td><strong>Browse</strong></td>
<td>Opens a browser window. You can select a folder in which data is buffered before and during the burn process.</td>
</tr>
<tr>
<td><strong>Minimum space on hard drive, which Nero should not use</strong></td>
<td>Defines the minimum storage volume on the cache drive that is not used by Nero Express.</td>
</tr>
<tr>
<td><strong>Immediately cache files that have been copied from an optical drive</strong></td>
<td>Saves files that have been added to the compilation from a source disc in a temporary directory. If you clear this check box then you have to insert the original source disc during the burn process.</td>
</tr>
</tbody>
</table>

16.3 Expert Features

The following configuration options are available on the **Expert Features** tab:

<table>
<thead>
<tr>
<th>Check box</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enable Disc-at-once CD over-burning</strong></td>
<td>Enables the option that CDs can be overburned.</td>
</tr>
<tr>
<td><strong>Absolute/Relative maximum overburning size</strong></td>
<td>Defines how much a CD can be overburned.</td>
</tr>
<tr>
<td><strong>Enable DVD overburning</strong></td>
<td>Enables the option that DVDs can be overburned.</td>
</tr>
<tr>
<td><strong>Maximum DVD size</strong></td>
<td>Defines how much a DVD can be overburned.</td>
</tr>
<tr>
<td><strong>Enable generation of short lead-out</strong></td>
<td>Enables the option to write additional data to your CD.</td>
</tr>
</tbody>
</table>
### Configuration Options

<table>
<thead>
<tr>
<th>Check box</th>
<th>Do not eject the disc after the burn is complete</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check box</td>
<td>Enables the option that your disc remains in the recorder and is not ejected when the burn process is finished.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Check box</th>
<th>Enable all Nero supported disc types for the Image Recorder</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Enables the option that all supported recorder formats for the Image Recorder are available.</td>
</tr>
<tr>
<td></td>
<td>It is now possible to create compilations that the installed recorder cannot burn. For instance, you can create a Blu-ray compilation without a Blu-ray recorder and create an image file with Nero Image Recorder.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Check box</th>
<th>Enable automatic renaming of AVCHD file extensions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Renames the file extensions to fit the AVCHD specifications. AVCHD content on optical discs requires four letter extension to be detected as an AVCHD disc.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Area</th>
<th>Nero burn functions in the context menu</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Allows Nero Express to be started from the shell context menu. The shell context menu offers various pertinent information and is opened by clicking a file or folder with the right mouse button in the Windows Explorer.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Area / Button</th>
<th>Restore</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Resets all settings back to the original factory settings.</td>
</tr>
</tbody>
</table>

**Overburning**

Overburning means writing more data on the disc than originally intended. It is achieved by reducing the lead-out area to a few seconds, which is sufficient in most cases. However, this violates the CD standard and may result in recording and playback errors (depends on the used recorder).

### 16.4 Ultrabuffer Settings

The following configuration options are available on the Ultrabuffer tab:

<table>
<thead>
<tr>
<th>Selection list</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection list</td>
<td>Method</td>
</tr>
<tr>
<td>Selection list</td>
<td>Method</td>
</tr>
<tr>
<td>Input field</td>
<td>Data buffer size</td>
</tr>
<tr>
<td></td>
<td>Defines the memory capacity that Nero Express uses as a RAM buffer.</td>
</tr>
<tr>
<td></td>
<td>The ultrabuffer is a second memory that enhances the physical buffer in the recorder.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Input field</th>
<th>Data buffer size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input field</td>
<td>Data buffer size</td>
</tr>
<tr>
<td>Input field</td>
<td>Data buffer size</td>
</tr>
<tr>
<td></td>
<td>Defines the memory capacity that can be manually entered.</td>
</tr>
<tr>
<td></td>
<td>The input field is only enabled when Manual Configuration is selected in the selection list.</td>
</tr>
</tbody>
</table>
16.5 LightScribe Settings

The following configuration options are available on the LightScribe tab:

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print contrast</td>
<td>Adjusts the desired print quality.</td>
</tr>
<tr>
<td>Selection list</td>
<td></td>
</tr>
<tr>
<td>Default LightScribe drive</td>
<td>Selects the drive with the LightScribe recorder.</td>
</tr>
<tr>
<td>Selection list</td>
<td></td>
</tr>
<tr>
<td>Genre</td>
<td>Specifies the genre.</td>
</tr>
<tr>
<td>Selection list</td>
<td></td>
</tr>
<tr>
<td>Current template</td>
<td>Defines a template for labels.</td>
</tr>
<tr>
<td>Selection list</td>
<td></td>
</tr>
<tr>
<td>Default print resolution (DPI)</td>
<td>Adjusts the desired print resolution.</td>
</tr>
<tr>
<td>Check box</td>
<td></td>
</tr>
<tr>
<td>Always print LightScribe label</td>
<td>Offers the option to create and burn a LightScribe label automatically when burning with a LightScribe recorder. This tab is only available if a LightScribe recorder has been installed.</td>
</tr>
</tbody>
</table>
17 Glossary

AIFF
The Audio Interchange File Format is an uncompressed audio file format from Apple® and represents a sort of counterpart to the WAV format from Microsoft. Files are larger than when using a compressed format, but the quality is higher. AIFF compressed is the compressed variation.

Archive Bit
Archive bits are used to identify files that have been edited. A file is only resaved during the next backup process if it was edited (and an archive bit is thus reset).

Audio CD
An Audio CD can contain up to 74 minutes of audio sequences and individual tracks in hi-fi quality. The storage capacity is 747 MB at a sample depth of 16 bit and a scan rate of 44.1 kHz.

AVCHD
AVCHD is an HD capturing format for camcorders. It is used for DVDs but compatible to Blu-ray Discs.

Block
A block refers to the smallest information unit on a CD-ROM or hard drive that is addressable in one access and that is indicated in bits or bytes. Several blocks are combined into a sector.

Book Type
The book type defines the specification (e.g. DVD-, DVD+, DVD-ROM) of a DVD. In order to ensure correct playback, the DVD specifications are defined in books so that all media can be read correctly. The specifications are defined in the so-called Rainbow Books, which are distinguished by means of their color (e.g. Yellow Book).

Buffer
A buffer refers to temporary memory that records and delivers data that cannot be processed immediately as required. The buffer also allows for continuous data flow.

Buffer Underrun
A buffer underrun is an interruption in the data flow in the internal memory (e.g. of the recorder). A buffer underrun results from an interruption in the data flow to the internal buffer. The buffer continues to deliver data until it is finally empty. When recording, data is fed continuously to the recorder's buffer in order to keep a steady flow of data. If the steady flow of data is interrupted, the media becomes unusable. Most modern recorders have a protective mechanism against buffer underruns.
Cache
Cache is a faster buffer that is used in various areas of a computer to access larger data volumes faster. Cache ensures a continuous flow of data.

CD-R
Compact Disc-Recordable is a technology for write-once media. The Orange Book standard defines the storage of audio data and other computer-readable data.

Disc-At-Once
Disc-At-Once refers to a method in which the laser in your disc burner burns the disc in one pass without turning off and on between each track. This method is best when recording Audio CDs you would like to play in your home or car stereo.

Frame
With an Audio CD, 75 sectors provide one second of played music. One sector consists of up to 98 frames; one frame contains 24 data bytes and 9 control bytes. Similarly, “frame” describes a full screen in television and video technology. Two successive half images result in a full screen within a second due to interlacing.

Image
An image refers to a single file on the hard drive that contains the image of a complete disc. A disc image can be used to create exact copies on media at a later point in time if problems occur during the write process or if no recorder is connected to your PC. The image requires as much free space on the hard drive as the contents of the original disc take up.

Joliet
Joliet refers to an extension of the ISO-9660 standard for file names. Joliet was designed by Microsoft in order to represent more characters. The file name can be up to 64 characters long and contain the letters A-Z, a-z, umlauts, as well as characters from Chinese, Japanese, and Korean.

Label
A label refers to a label on a disc. Some drives, e.g. drives that use LightScribe or Labelflash technology, can transfer labels directly to special media.

Labelflash
Labelflash is a technology with which pictures and texts can be burned on the label or data side of a disc with a laser.

LightScribe
LightScribe is a technology with which pictures or texts can be burned on the label side of discs with a laser.
**MP3**
The MPEG-1 Audio Layer 3 audio format is used to reduce the size of audio files to a fraction of their original size (factor 1:10) with little loss of quality. You can estimate about 1 MB per minute as opposed to 10 MB for the original files. This value and the quality can vary depending on the complexity of the audio signal. The bit rate used can be used as a measure of quality. The higher the bit rate, the better the quality, but also the more memory required.

**mp3PRO**
mp3PRO is an MP3 codec that compresses audio files even more but in lower bit rates and better quality. 64 kBit/s in mp3PRO is the equivalent to 128 kBit/s in MP3.

**Multisession**
A multisession refers to completing a disc in multiple cycles. After a first session has been written to the disc, information can then be added in another record because the disc has not been finalized.

**Nero AAC**
Various MPEG-4 video and audio codecs are collated in Nero AAC and are fully compatible with the standard MPEG-4. Nero AG is continuing to develop these. In this way a substantially higher quality of the multi-media data is achieved. Further, additional features such as subtitles have been implemented.

**On-the-fly**
On-the-fly refers to a method for copying to a disc. The data is transferred directly from the original storage location to the disc to be burned. To do this, Nero uses a compilation, a small file that simply refers to the transferred data.

**Track-At-Once**
Track-At-Once refers to a write method in which each track is written to the disc individually. The writing process is interrupted briefly after each track, i.e. the laser starts again for each track. With this write method, it is only possible to continue writing to a DVD sometimes and at a later stage. There is a pause of at least 27ms between tracks, which can be disruptive for Audio CDs.

**WAV**
The WAV audio format, also called WAVE or Waveform audio format, is an audio format from Microsoft and uses no data compression. WAV is the counterpart to the AIF format from Apple.
18 Index

Audio CD
CD Text ........................................ 56
Convert ........................................ 35
Copy an Audio CD ................................ 60
Copy tip ........................................ 59
Creating ........................................ 22
Cross fade with previous track ............ 26
Identify with Gracenote ...................... 29
Obtain metadata ................................ 29
Save to Computer ................................ 31, 35
Track properties ................................ 24

Audio file
Add Album Art ................................... 38
Declick .......................................... 28
Fill titles ........................................ 36
Filter ............................................. 27
Identify with Gracenote ...................... 29
Indexes .......................................... 26
Normalize ...................................... 28
Obtain metadata ................................ 29
Save to hard drive.............................. 36

Burning
Burn Settings .................................... 56
Choose burner .................................. 53
Overburning .................................... 76
Start the burn process ....................... 54
Use Image Recorder ............................ 53, 55

Compilation
Create Audio CD ................................ 22
Create Blu-ray Movie .......................... 40
Create Data disc ................................ 15
Create DVD Video ................................ 39
Create Jukebox disc ............................ 29
Load disc image ................................ 44
Load saved project ............................ 44

Configuration options ....................... 74
Conventions, manual ......................... 5
Copy
Copy a disc ...................................... 60
Copy over image ................................ 59
On-the-fly ....................................... 59
Quick copy ...................................... 61
Select source and destination .............. 62

Data disc
Copy a data disc ................................ 60
Multisession .................................... 57
Save data track as image file .............. 20

Data Track ....................................... 20
DiskT@2 .......................................... 49

Gracenote ........................................ 6, 30, 32

Image
Create from data disc ......................... 20
Create image file ................................ 55
Load image file ................................ 44

Image Recorder ......................... 53
Activate Image Recorder ..................... 53
Enable all supported formats ............... 77

iPod ............................................. 38

Labelflash ....................................... 49
Burn label ....................................... 51
Create label .................................... 49

LightScribe ...................................... 45
Burn within the compilation .................. 47, 78
Printing Labels ................................. 45
Set options ..................................... 78

Manual, conventions ....................... 5

Music
Compile Audio CD ............................... 22
Compile Jukebox disc ......................... 29

Nero CoverDesigner ...................... 47, 49
Nero MediaBrowser ......................... 71

Nero SecurDisc Viewer ..................... 67
Check data integrity ......................... 69
Checking the signature ....................... 70
Copy data from SecurDisc disc ............. 68
Remove password protection ............... 68
Starting .......................................... 67
Verifying authenticity ....................... 70

Program
Exit the program ............................. 66
Starting the program ......................... 7
Use of the program .......................... 5
Versions ........................................ 6
Rewritable disc

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Erase</td>
<td>64</td>
</tr>
<tr>
<td>Erase method</td>
<td>65</td>
</tr>
</tbody>
</table>

Screen

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>AVCHD(TM) Files</td>
<td>42</td>
</tr>
<tr>
<td>BDMV Files</td>
<td>41</td>
</tr>
<tr>
<td>Disc content</td>
<td>15, 16</td>
</tr>
<tr>
<td>DVD-Video Files</td>
<td>39</td>
</tr>
<tr>
<td>Final screen</td>
<td>66</td>
</tr>
<tr>
<td>My Audio CD</td>
<td>22</td>
</tr>
<tr>
<td>Source and Destination</td>
<td>60, 62</td>
</tr>
</tbody>
</table>

SecurDisc

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About SecurDisc</td>
<td>67</td>
</tr>
<tr>
<td>Digital signature</td>
<td>18</td>
</tr>
<tr>
<td>Explanation</td>
<td>16</td>
</tr>
<tr>
<td>Limit data redundancy</td>
<td>20</td>
</tr>
<tr>
<td>Nero SecurDisc Viewer</td>
<td>67</td>
</tr>
<tr>
<td>Password protection</td>
<td>17</td>
</tr>
</tbody>
</table>

Start

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Via Welcome Application</td>
<td>8</td>
</tr>
</tbody>
</table>

System requirements          | 8    |

Video

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compile an AVCHD video disc</td>
<td>42</td>
</tr>
<tr>
<td>Compile Blu-ray Movie</td>
<td>40</td>
</tr>
<tr>
<td>Compile DVD-Video</td>
<td>39</td>
</tr>
</tbody>
</table>

Window

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Erase Rewritable Disc</td>
<td>64</td>
</tr>
<tr>
<td>Save Audio Tracks to Hard Drive</td>
<td>35</td>
</tr>
<tr>
<td>Select Track</td>
<td>20</td>
</tr>
</tbody>
</table>

Work overview                | 7    |
19  Contact

Nero Express is a Nero AG product.

Nero AG
Im Stoeckmaedle 18
76307 Karlsbad
Germany
Internet: www.nero.com
Help: http://support.nero.com
Fax: +49 724 892 8499

Nero Inc.
330 N Brand Blvd Suite 800
Glendale, CA 91203-2335
USA
Internet: www.nero.com
Help: http://support.nero.com
Fax: (818) 956 7094
E-mail: US-CustomerSupport@nero.com

Nero KK
Rover Center-kita 8F-B, 1-2-2
Nakagawa-chuou Tsuzuki-ku
Yokohama, Kanagawa
Japan 224-0003
Internet: www.nero.com
Help: http://support.nero.com

Copyright © 2013 Nero AG and its licensors. All rights reserved.